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Using the Internet

The Internet is a global network of computers linked together by phone lines that enables information to be exchanged between computers anywhere in the world.

Access to information on the Internet can be gained using Netscape Communicator. Netscape Communicator is browser software which allows you to search and retrieve information. Information can be in various forms, text, graphics, audio and video files. Audio and video files can only be downloaded if your computer is capable of handling these files.

Loading Netscape
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Selecting the Netscape Communicator icon with the mouse and double clicking on it will load the program. The home page for the Institute of Education is loaded first. 
[image: image3.png]of London Home Page - Netscape MEIE
Fie Edt View Go Commuricator Help

| & & 3 ¥ a &S & 3 -
Gl Foved Beoad Home  Seach Nelwwe P Secuiy  Siup
¢ Bookmaks _ Localon i /wwmioe.ac k7 <] @ whats Reaed

|
INSTITUTE OF

EDUCATION

UNIVERSITY OF LONDON

> About the Institute > Academic Groups » Administrative Depts
Welcome from the Director Subject Area Departments and Interal Information
The Instinutés Mission
Role of the Institute > Centres & Units P This Week Newsletter
Officers of the Institute Teaching & Researdh Latest Neus and Events
Daes of Terms and Closures
Location and Access > Courses of study P Press Office
Howto Contazt Us Associateship, BEd, Diploma,  Lagest Press Releases

INSET, Mastar's Degrees,

P student Information Online, PGCE, Presessional, B Conferance Office
‘Accommodation Research Degroes, Short,etc. Conforences and Facilities
Fees
Studentships »information Services - Publications
Nursery & Health Facilitiss  Computing Library & Media  and Bookshop at the [oF,
Students' Union
Equal Opportunities > Research Projects » Alumni Association
‘Students with Disabilities Directory of Funded Research  Keeping in Touch.

¥ Institute Address and Contact Information
¥ Recent Institute of Education Web Site Developments
S| [Document Dane AT M V)

g start| | 2 Felix B Mictosaft Word - nto o int..| [F Institute of E ducation. | GADE o333





[image: image4.png]MEIE

Fle Edt View Go Commuricalor Help

< ¥ A A 2 m I & FH

Back  Fousd Rekad  Home  Seach Melsoape Pint  Secuiy

iz

<" Booknatks . Loostons [t/ /mwnioe 5o i/infoser Trarng i =] @ Whats Related
—

INSTITUTE OF

eeimion Information Services%y

nformation Services_ Training
IS Home Page. ) > Computing Training

»Library Information Skills Training

ABackto Information Services Home Page

& Backto Institute of Education Home Page

2 This page is maintained by Brian Lienard, IS, eabrian@ioe ac.uk

@ This page First Created on 13 Decernber 1999, This Menu Last Updated on 14 January 2000

= D= Tt Ao o, ac.uk fes riringinder him £ 22 @ 2
g start| | 2 Felix | |87 Mictosoft Ward - nta to int..| [ 10E Information Servi. | FaDE 100




[image: image5.png]et Searct

etscape. MEIE

Fle Edt View Go Commuricalor Help

< ¥ A A 2 m I & FH -

Back i Rebsd  Home  Seach Netospe Pt Sseuty o
Bookmarks 4 Netste ' Fhome ntscape con/escapes sesrchinetsearch Ol <] @ Whas Rekaed
i Netscape Search | WebMail | My Netscape | Buddy Chat | Help | Download
My Netscape | Buddy Chat | Help

. New! introduction to

Communicator D Click Here
Click Here! Click Here!

You are here: Home > Net Search Page > Netscape

Netscape Search Tigs
Excite Search
GoT0.cOM I~ Keep Netscape as my search engine
HotBot Categories: Eootball Maps About Searc]
LookSmart  gifins e T e
Lycos Email Horoscopes Pokemon People Finder
Snap Eeal Estate Intemet Keywords
Screen Savers Search FAQ
About.com Net S h  Sootslews Shedock Flugin
Google etscape >earch gy Maps/Directions

TryThese: | Amazon.com | Netmarket | Friends | CONOW | Buyers Guide

o ==
g start| | 2 Felix

[Document Dane B T N B
| |87 Mictosoft Ward - nta to nt..| [ Net Search - Netscape | TaDE 1021





[image: image6.png]of London Home Page - Netscape
Fle Edt View Go Commuricalor Help

| & & A 4 a &S & 3 -
P Fowsd Feosd fome  Sewch Newspe Pt Sewty i

" Bocknatks ) Loostors[F//emnios 3o =] @ Whats Related
—

INSTITUTE OF
EDUCATION

UNIVERSITY OF LONDON

> About the Institute > Academic Groups » Administrative Depts
Welcome from the Director Subject Area Departments and Interal Information
The Instinutés Mission
Role of the Institute > Centres & Units P This Week Newsletter
Officers of the Institute Teaching & Researdh Latest Neus and Events
Daes of Terms and Closures
Location and Access > Courses of study P Press Office
Howto Contazt Us Associateship, BEd, Diploma,  Lagest Press Releases

INSET, Mastar's Degrees,

P student Information Online, PGCE, Presessional, B Conferance Office
‘Accommodation Research Degroes, Short,etc. Conforences and Facilities
Fees
Studentships »information Services - Publications
Nursery & Health Facilitiss  Computing Library & Media  and Bookshop at the [oF,
Students' Union
Equal Opportunities > Research Projects » Alumni Association
‘Students with Disabilities Directory of Funded Research  Keeping in Touch.

¥ Institute Address and Contact Information
¥ Recent Institute of Education Web Site Developments
S| [Document Dane AT M V)

g start| | 2 Felix B Mictosaft Word - nto o int..| [F Institute of E ducation. | GaDE 10




[image: image7.png]Fle Edt View Go Commuricalor Help

of London Home Page - Netscape

Boc

Foward  Reload  Home  Search

Nelscape

4 @ A DF 2 m I & F

Fint  Secuiy S

" Bocknatks ) Locations

it 7w ios.ac.uk/

=] @ whats e

=

INSTITUTE OF
EDUCATION

UNIVERSITY OF LONDON

> About the Inst
Welcome from &
The Institutés b
Role of the Insti
Oficers of the I
Dates of Terms ¢
Location and A
How to Contast

Ente the Workd Wide Web location (URL) o specily the local fle you would

like to open:

Openlocation o fle in

€ Composer
& Navigator

=

Choase Fik.

Help

P student Information

Online, PGCE, Presessional, - Conference Office

‘Accommodation Research Degroes, Short,etc. Conforences and Facilities
Fees

Studentships »information Services - Publications

Nursery & Health Facilitiss  Computing Library & Media  and Bookshop at the [oF,

Students' Union

Equal Opportunities
‘Students with Disabilities

¥ Institute Address and Contact Information
¥ Recent Instinite of Education Web Site Developments

> Research Projects
Directory of Funded Research  Keeping in Touch.

> Alumni Association

o ==
A start|

& Feli

S Ve 9P @ 2

[ Vit . [ ettt of Eduation

| TaDE 1051



[image: image8.png]Netscape is unable to locate the server:
news Server
The server does not have a DNS entry.

Check the server name in the Location (URL)
and try again.





[image: image9.png]Fle Edt View Go Commuricalor Help

MEIE

v ¥ A A4 2 W P &

" Bocknatks 4 Locatos s /vwioe sk s inng/mden i

=] @ whats e

INSTITUTE OF
EDUCATION

UNIVERSITY OF LONDON

Computing Service Training

o General Course Information
o Course Dates - Spring 2000

 Course Guide - Course details and prerequisites
o Self-Help Software Guides
o Computer Based Traifin|

o Links to Other Training Resources

&

W Micoo.. [ Trai.. | HMyC.. | yDatal] _ydaaP.| ez

e e AP [ N
internet| .| (59 GEIDE 1110am




[image: image10.png]etscape 171 x]
File Edt View Go Communicator Help
7 3 N 4 > 3 3 "
v ¥ A 4 » W@ S & #
B e Gm o G W B G
§ Bookmarks  AddBookmark fr <] @7 whats Related
t Fie Booknark ,
— £k Boskmais 5
INS' (4 sking
ED1 s

UNIvE: ( gemes
& avel

2 wainng

Compt =0y

2 user suppent wak

Cpivae

 wobefied

2 Home Page
o General Col 4 ke ,

0 Course Dalt g JPEG image 13004331 pisels
© Course Gui¢ 2 oskiTak - euope
@ Self-Help St 2 Vel Thorens, thefighest sk resotin Europe.

o Computer B # FAQ
o Links to Otfy 2 Amsterdm Hote Gide..m- The Nethedands )

4 s Hotel Guie.m - The Netheands
2 roel3

4 STA Trsvel-Book It

4 MetsCrsaions | Paner lssic

# MetsCrsaions  Dowrloads

e — s g
Astart| 3 Feln | WMo [T Trai . Bwyc. | Datar ydatep.] el | yirtemet| [Hadh.. | e @A@Y 1117




[image: image11.png]‘Commuricator

Eoyerd
Home.

2Val Thorens, the h.
3 Course Guide

Proc 5 Couss Guide
§ Training menu

@ MMouen
- Lo

Wi

Document: Dane

Help

v OMetaCiestons | Painter Classic:
1 Amsterdam Hotel Gu..m - The Netherlands )

skiresort in Eutope

4 GeneralCourselnformation

2 10E Information Services Training
8Instiute of Educa..on Services Home Page

PainterClassi that ampawer thelr creatvty.

MEIE

e

bt Secuiy S

Moamordaer =) WhatsRelaed

ct Buy Download MetaStream

PainterClasso provides developing digital
atists and beginning web designers with an
Slegant, quickto leam and use digita painting
teshnology, whetharwoking from exising
arbuot or painting flom serats. Painter Classio
contains a simplified, organized set of
NaturabMedia® tool, including pain, chak,
pen and others 5o that auotk looks hand
drawn and organic, not like computer ar
PainterClasso offar nteligent recognition of
ither 3 mouse or tablet 2o crastivty in dawing
nd painting s maximizad. Graphic designers,
mulimedi designess ilustrators and
Haditional it il ind he tools they need in

hstart| 3 Feln | rMice.|[FEMe DMy | sbat. | ydsta.| vele | yinter.| [ado.|

BADE 120an



[image: image12.png]esources - Netscape. 171 x]
Fle Edt View Go Commuricalor Hep

< ¥ A 4 » =+ & B -
Back  Foud Reoad  Home  Seach Netcope Pim  Seowly  Sip

Bookmarks 4 Locators /7w ow 30 ICS pgeeiotesoroesy =] @ Whats Related

* To provide information ahout resources including software, CD ROMs, articles, and hooks relating to ICT
within an education context which might be useful for PGCE tutors and students.

* To provide a forum for sharing ideas and evaluating ICT resources which would he appropriate for use within
the Institute.

Back
Eoyerd]
Reload

o Siop

View Source
i View Info

3
View Image (b gf)

.

e ' SetasWalpaper .

R ICT Publica  addBooknark Evaluating CDs

- Create Shortcut

 Please give feedback and any information about ICT _ SendPage iink would he useful for other
PGCE tutors and students. Please type out your cont Savemage s to Rebecca Wilson.

* Contact: Rebecca Wilson, ICT Teaching Support An —————————lices. email pwilson@ioe.ac.uk

TelX 6609. (mhis pageas lastupaated nty 16 1999 )

Copy Image Location

Netscape
g start| | 2 Felix

B Microsat..| My Com...| _sData ;) | [BAdobe P.. [ Resou. | GaDDT 112am




[image: image13.png]Fle Edt View Go Commuricalor Help

oo o
technology consortia finded by U.5. Department of Education, Office of Education Research and Improvement.

Yahoo
‘wrw.yahoo.com/

..Then fry these tools!

Lycos
warwlycos.com/

Starting Point
www.stpt. com/

AltaVista
‘wrw altavista. com/

Excite
‘ww exite.com/

Infoseek
infoseek go. com/

Metacrawler
‘wrw.go2net. com/
search himl

Magellan
‘magellan excite.com/

Ask Jeeves
www.askieeves.com

Internet Sleuth
‘wrw isleuth, com/

Argus Clearinghouse
www.clearinghouse.net/

MiningCo.
www miningco com/

Schrock's Guide
discoveryschool com/

Blue Web'n
‘wrarw Jen pacbell cor/

Connections +
‘wrw merel org/connect!

schrockguide/

‘wiredibhiewebn/

plusfindex asp

Switchhoard
‘wrw switchboard. com/

MapQuest
Www.mapuest.com/

Research-Tt!
‘wrw frools. comresearch-itf

K-12 Weblinks Database
‘wrw tre.ucf edulle12db/

EvaluTech
‘wrw evalutech sreb.ory

FREE
worw.ed.govifree/

Dooumert Dore

Sl e @D [E N2

B Microsaft Word

WO nzran



[image: image14.png]3 Internet Search Tools-
File Edt View Go Communicator Help

AltaVista | AltaVista Excite Infoseek Lycos Yahoo
(Simple Search) |(Advanced Search)
. altavista. cota . ltavista corn . excite.cotn|wowvw.infoseele cora ww lycos. com | www.yahoo.cor
And doats tpers | oS ANDpetsjeats ANDpets |y o tpers | oats tpets
cats & pets | eats Hpets
or cats kittens cats OR kitens | cats OR kitens | cats, kiens | 0o 220vanced | Use Advanced
Search Search
cats AND NOT
Not toas wid | °%8 AND NOT wild eats wid | oats wld | oats -wild
wild
+eats -wild
B | | e | e | e | e | Cpeca
(cats or itens) | (cats or kitens)
Complex | Use Advanced Use Advanced
Searching | Search AvD AvD A Search A
NOT wid NOT wid
Truncation/ cat* cat* Automatic .
Wild Card | wom™ worr™n suffies A A o
Use Advanced
mary-latmb iy Search
Proximity - mary NEAR lab | N/A WA WA
(itin 10 worc) | (o 00 (wittin 25
words)

s developed for you by the Instrustional Technology Resource Center (ITRC) and may be downlosded from Bilp: /i e ucf edufias/

Florida ITRC & SUNLINK Projects * University of Central Florida * 12443 Research Patiavay, Suite 402, Orlando, FL 328263282

Kl \

Document Done. e Ve

asnan T ntornet Search Tooks .| B Mictosolt Word T 112480




The World Wide Web can be described as the multimedia section of the Internet as it gives you pictures and sounds in addition to a vast array of textual information. It makes information available in Hypertext format. Each page has hypertext links to other related pages. The links are the sections of text which are underlined and in colour, usually blue. Links may also be assigned to graphics. Clicking on these sections activates the link to the page. 
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You can identify whether text or a graphic is a link by hovering your mouse over the text and looking for the hand symbol.

Accessing Other Pages

To access other pages there are 2 options:

1. Use a Search Engine

2. Enter the unique reference for the location of the information

1.
Using a Search Engine

A search engine is a service on the Web that helps you find what you are looking for. You provide key words and the search engine comes up with a list of Web sites that contain them. 

One way of loading a search engine is to click on the Search button on Netscape's toolbar and a new page will load which provides a space for you to type in the Keyword or group of keywords for your search. 


The outcome of a search can be overwhelming as it can provide many thousand web sites as a result of the search. There are ways of narrowing your search. You can access information on how to do this by clicking on the Search Tips link. There is a useful summary of search engines and the methods used to narrow your search for each at the end of this document.

Each search engine may provide different results so is worth trying more than one and comparing results.

2.
Entering the unique reference for the location of the information

Each web page has a unique address for its location. These addresses are sometimes referred to as URLs which stands for Uniform Resource Locator.

For example http://www.ncet.org.uk will open the National Council for Educational Technology (NCET) home page. 

You can either type the address for a location in the Location window at the top of any web page and then press the Return key on your keyboard



Or,

You can select Open Page from the File menu to call up the following dialogue box:

(The shortcut for this is to press CONT + O on the keyboard)


Type in the URL or address you require and then click the Open button.

Either method will initiate the browser to attempt to make a connection to your chosen location. The connection may be made in seconds or it may take up to a few minutes. The length of time that a page takes to load depends on where it is coming from and the content of the page. Mainly text loads faster than a page which is mostly graphics. The Status bar at the bottom of the screen gives information on the progress of the transfer of data. A page with graphics will take longer to load. The text will load first followed by the graphics. It is possible to click on a hypertext link and move to the next page before the graphics are fully loaded

When attempting to make a connection to a location an error message may appear. 


This indicates that the server issuing the page may be temporarily shut down or too busy with other connections to handle your request. It is always worth trying again but make sure the address is correct if you have entered the location
Back/Forward/Home

Clicking on the links within each page, either underlined text or graphic links will load further pages of information. You can navigate back to previous pages and then forward again to the present page using the Back and Forward buttons on the toolbar.


Clicking on the Home button on the toolbar will always take you back to the Institute of Education Home Page.

Bookmarks

Pages which you have found useful can have their locations saved as a bookmark. These pages can then be subsequently loaded from the bookmark, this is useful when you have found information by progressing through many links between pages. 


To bookmark a page click on the Bookmark button on the toolbar or select Bookmark from the Communicator menu.

The following dropdown menu will appear:


Add Bookmark

will add the current web page to the list of bookmarks

File Bookmark

will give you the chance to file away the new bookmark in a folder which you have previously created 

Edit Bookmark

will give you the chance to edit any of the bookmarks or create bookmark folders

Using Go


Go is a useful facility as it gives you a history of the pages already loaded as a list. It is then possible to revisit a page by selecting from the list without retracing your way back through all the links. 

To use, click on Go in the menu bar and select which location you wish to go to next.

Printing

An option to print pages is available in Netscape. However you may find that some information will print successfully while others pages will not. This depends on the capability of the printer to handle commands from the Netscape software. 

Print by either selecting Print button on the toolbar or by selecting Print from the File menu. The latter method will give you the chance to select how many pages you wish to print.

Saving Text Files

Pages can be saved as text files which can then be opened by word processing programs and be printed or edited.

Only the text on the page is saved, any other media on the page is not saved.

Click on the Save as command from the File menu. Select Plain Text (*.txt) from the Save File as Type option and then enter a filename, including the .txt extension. The file can be saved as the default type Source (*.htm) but this will display Hypertext codes when loaded into a word processing program. The saved .htm file can be loaded in Netscape using the Open File command in the File menu. Information can then be looked at off-line which can be a cheaper option, particularly at home or in schools.

Copying Text 

Hold down the mouse button in the content area and drag to select portions of text. Then select Copy from the Edit menu to copy this selection to the clipboard. The copied section can be pasted from the clipboard into a word processing file.

Saving Graphic Files

Graphics files can be saved in jpeg (only using Internet Explorer) or gif formats to any drive or a floppy disk. These are standard formats for digitised images and the file format used to store the image will be given when you save the file. Once saved to a drive the graphic file can then be opened in a graphics program or inserted into a word processing or desktop publishing file.

To save a graphic :

· move the mouse pointer inside the graphics image area. 

· right-click the graphic and the following shortcut menu will appear:

· Select Save Image As
· In the Save As dialogue box select the location you wish to save the file to and change the name of the file if necessary.

Saving Video Clips

Video clips can be saved as avi, mov mpeg or files. To show graphics or play video clips you need to use software such as Quicktime which includes Picture Viewer and Movie Player or they can be assembled in a multimedia presentation using a program such as HyperStudio.

Useful Internet Pages for Education

NCET:  (National Council for Educational Technology) is involved in a number of projects which aim to encourage the use of Information and Communications Technology in education. Their home page is located at 

http://www.ncet.org.uk
NCET: NCET's Internet publication Highways for Learning: the Internet for schools and colleges is written for classroom teachers and managers in schools and colleges. It is available in text form on the Web. 

http://www.ncet.org.uk/publications/highways/
DfEE: The Department for Education and Employment has a comprehensive web site with all the latest government education papers, which can be downloaded.

http://www.dfee.gov.uk
BECTa: British Educational Communications and Technology Agency. This site includes a wide range of ICT information, projects and resources. There is also access to the National Grid For Learning (NGFL) and the Virtual Teachers Centre.

http://www.becta.org.uk
OFSTED: The government inspection body site where all school inspection reports are published. This is useful for researching placement schools or potential employers.

http://www.ofsted.gov.uk
NGFL: This recent Government initiative aims to have all schools connected to the Internet by 2002, thereby creating a National Grid for Learning. This web site is a collection of resources brought together by the Government. 

http://www.ngfl.gov.uk
BBC: This is a useful internet starting point as there is a list of useful sites and links for each subject. A short description is given so you have a flavour of what might be available. Use the BBC Bitesize revision site to test your own GCSE subject knowledge!

http://www.bbc.co.uk/education
The Institute of Education: Information about courses, facilities and help for students is on our web site.
http://www.ioe.co.uk 

PGCE Support: There is a Web site within the Institute site specifically for PGCE Students.

http://www.ioe.ac.uk/ics/pgceictresources
TTA: This site gives information about all recent Teacher Training Agency initiatives, policies and documents.

http://www.teach-tta.gov.uk
Campus World: Communications projects and on-line resources for education

http://www.campus.bt.com
Schools Online: Project to support the development of curriculum materials in Science and Languages

http://sol.ultralab.anglia.ac.uk/pages/schools_online/
Media Site:  Provides access to International newspapers, magazines and broadcast material.

http://www.potter.net/mediasite
Research Machines: This site has RM’s Internet for Learning pages which provide thousands of links for a wide range of curriculum topics. Most of the information is only available to subscribers to RM’s service. The Eduweb section provides links to UK schools who have Web pages. Links to many other educational organisations and professional bodies are also provided as well as a classroom forum for teachers

http://www.rmplc.co.uk
TONIC The Online Netskills Interactive Course

To take you further you can access an on-line structured course on using the Internet which has been developed for UK higher education at 

http://www.netskilss.ac.uk/TONIC
Search Engine Summary

Try searching for a topic using at least three different search engines and compare your results.


The Search Tips link will take you to a page leading to useful tips for entering keywords as the search criteria for various different search engines





Toolbar Buttons


Activate Netscape features most commonly used





e.g. 


go back to previous page, reload page, 


go to home page, 


print





� EMBED Word.Picture.8  ���





Hypertext links


Clicking on these links will take you to another page 





Status bar


Gives information on the progress of your request





Web site address
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